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Background
AUTODEPOMOD incorporates SEPA’s new methodology for determining marine fish-
farm biomass limits. Attendees of the workshop will learn how to use the software and
test various scenarios to optimise site usage.
The DEPOMOD model and automated software AUTODEPOMOD are a result of
several years of scientific research and development. Workshop participants should
therefore expect that pre and post-workshop effort will be required before becoming
conversant with the software and the regulatory method.
Workshop objective
The objective of the workshop is:

e Familiarisation with the AUTODEPOMOD software and some scenario testing
Overview
The model will be set up for the hypothetical Eck site, with emphasis on which data are
normally site specific and which are default. Hydrographic and bathymetry data are
available for this site and users may have time to set up one of their own sites with the
software.
Workshop contents and check list
DEPOMOD background
Regulatory method background
What information is needed to test a site
Setting up AUTODEPOMOD for a site and iterating to a solution
Scenario testing

Submitting the right information

User own data modelling



Workshop exercises

Section 1 is a step by step guide to set up AUTODEPOMOD:

Before starting the exercises:

Decide on 2 different groups. Group A will set up cage layout A for Eck, group B
cage layout B.

Participants that have used the model before should pair up with a non-user if
necessary.

Scenario testing

Objective

To enable users to familiarise themselves with testing scenarios on cage layouts,
depth and dispersive qualities of the site

The user should undertake the following to test a particular scenario:

1.

Set up the model for a CONTROL scenario using either cage layout A or B
(detailed in section 1). For this CONTROL scenario it is important that
Autodistribute is checked ON and the default stocking density is decided upon.

Compare CONTROL results with the other group.

Now run a TEST scenario in the model to check its sensitivity and the effect on
dispersion and benthic impact. Always compare consent tonnage, stocking density
and cage numbers to the CONTROL run. It is important that recommended
stocking densities are not exceeded.



SECTION 1-STEP BY STEP SET UP GUIDE

All files for the site Eck are supplied with course material.

Some things to watch out for:

If the model crashes, users must make sure all instances of Excel and Surfer are
closed before restarting the AUTODEPOMOD software. After a crash, click on
Ctrl-Alt-Delete > Task List > Processes > Image name (to alphabetically sort) and
then select Excel or Surfer and End Process

When Surfer is newly installed on a machine, Surfer must be run once so that all
the run time libraries are set up correctly before running AUTODEPOMOD

To assist file naming and management with Windows Explorer, file extensions
should be visible. In Windows Explorer, click on Tools > Folder options > View
> Select Show Hidden Files and Folders. Also UNCHECK Hide Extensions for
known file types.

Exercise 1 — Grid generation

Objective — to set up the model with required information on bathymetry and cage

layouts

1.

Run the AUTODEPOMOD software, click on create New Project and enter a
name (EcK) for the new site. The software loads a number files and stops at FF-
in-Eck.xls. Fill in the site information in this sheet from Table 1 below and then
click Exit.

The following steps are undertaken on a computer that does not have C-map
installed and assumes the bathymetric data have been created by another package
or from survey data. Copy previously prepared files Eck.bln (coastline) and
Eck.csv (bathymetry) into the directory C:\SEPA
Consent\DATA\Eck\DEPOMOD\gridgen. Annex H gives details on the formats
of these files, but the user should view these files to examine their content.

A file called Eck.ini also needs to be created and the correct information entered
into it. Copy Blank.ini to the directory C:\SEPA
Consent\DATA\Eck\DEPOMOD)\gridgen and rename to Eck.ini. This file needs
to be edited to include grid origin limits only and any other information in this file
is ignored by AUTODEPOMOD. Open up the .ini file in a text editor (e.g.
notepad) and enter the information from Table 2 into the correct lines and save.
The main AUTODEPOMOD dialog has a Grid and Cage set up page which
includes a panel called C-Map files. When the cursor is placed over the boxes the
expected location is given in a hint box and also listed in Table A in the appendix.
Double click on the blank box next to Input (csv) and a dialog appears, select the
Eck.csv file. The .bln file is found automatically. Now repeat for the Settings



(ini) file specifying Eck.ini in the Gridgen directory if this is not automatically
found by the software (note: Eck.ini not the file SEPA-Eck.ini).

At this point, AUTODEPOMOD highlights a Coordinate mismatch, as the
origin limits specified in the ini file do not match the limits in the Cage Layout
sheet. Click on Edit Cages to enter the Cage Layout sheet which allows the user
to enter grid origins and cage layout information (maximum number of cages).
Bright yellow boxes contain information entered by the user, green boxes contain
derived information.

Enter the information in Table 3 into the spreadsheet carefully, using the GPS
input boxes if NGR data are not available. Lat and Long data should be entered as
decimal degrees into yellow boxes. The degree symbol is not necessary. e.g. enter
-5.44167 into cell R10 for cage group position 1 and hit Enter. Click on Centre
on average of all group centres at the bottom of the grid to centre cage group 1
into the middle of the grid.

Important notes

Distances between cages are the distance between cage centres
For round cages, cage size is the radius
For cage groups not in use, check either Nx or Ny is set to zero

7.

10.

1.

The origin of the grid in the Excel sheet (shown by cells P36, P37) now has to be
the same as the grid limits specified in the .INI file in step 3 (e.g. that in Table 2).
Enter x-axis and y-axis increment shifts as values greater than 0. Then move the
cages around the grid by clicking on the Cages up, down, left and right buttons at
the corners of the grid. The aim is to move the cages around until the Grid
Origin Easting E (m) is 192250 and the Grid Origin Northing N (m) is 825250.
The increment shifts may have to be changed to as low as 1 to get the exact
answer. Click on EXIT once complete.

As the origin in the Cage Layouts sheet now matches the origin in the .ini file (of
the bathymetric data), the Coordinate mismatch error message should have
disappeared.

Now click on Generate Grid file (this reads Refresh Grid Ref if maps already
exist), to create/update Surfer maps using all depth and cage layout information
recently entered. Surfer is either shown or minimised in the task bar. The grid can
be viewed by selecting the appropriate file in the Window menu option in Surfer.
When finished viewing, minimise Surfer.

Now click on Generate Grid File to create/update grids usable by DEPOMOD
(this will read ReCreate Gridgen Output if files already exist). A message
Gridgen files exist is now shown at the bottom of the AUTODEPOMOD dialog.
The alternative method to view the bathymetry and cage layouts is to browse to
the location C:\SEPA Consent\DATA\Eck\DEPOMOD\surfer and open the file
Eck-BENTHIC.srf.




If bathymetry, cage layouts or locations are changed at any point, the buttons
Refresh Grid Ref and ReCreate Gridgen Output should be clicked to update
Surfer and DEPOMOD Gridgen files.

A later exercise will test the effect of changing cage layouts or depth, so users will come
back to using this part of the software.



Table 1. Site information for Eck — All layouts.

Site Data

Consent #:

Site name:

Site NGR:

Receiving water:

Company:

Deadline for representations:

Bi-annual production (tonnes):
Peak biomass (tonnes):
Medicines applied for:

Current meter NGR:

Annual feed load (tonnes):

Input Data
Distance to shore (km):

Water depth at site (m):

# of cages:

Round/Square ?:
Diameter/Circumference/Width (m):
Working depth (m):

Treatment shallowing depth (range?) (m):

Eck

Loch Eck

All

0.23

Depends on layout

10

Circular
32m
16 m

Table 2. The origin of the bathymetric data specified in the Eck.ini file.

DataAreaXMin=192250
DataAreaXMax=193250
DataAreaYMin=825250
DataAreaY Max=826250

Table 3. Cage layout information required for the Cage Layout sheet — Cage Layout A

Input data variable Value

Current meter RCM position 57.27818 °
-5.4413 °

Cage group 1 position (Centre of N cage) 57.27820 °
-5.44167 °

Cage group 1

Cage orientation (from N cage)
Shape

Cage size-Diameter and Depth
Group spacing (x and y)
Other groups

10 cages (Nx) by 1 cages (Ny)

150 degrees
Circular

32 m (diameter) and 16 m

50 m (between cage centres)

Zero cages in groups 2 and 3 (set either Nx
or Ny to 0 for both groups)




Table 4. Cage layout information required for the Cage Layout sheet — Cage Layout B

Input data variable

Value

Current meter RCM position
Cage group 1 position (Centre of NE cage)
Cage group 1

Cage orientation (from NE cage)
Change symmetry

Shape

Cage size-Diameter and Depth
Group spacing (x and y)
Other groups

5 cages (Nx) by 2 cages (Ny)

150 degrees

Change symmetry on 1, so that cage 1
position entered above is the NE cage and
the second line of cages is in shallower
water

Circular

32 m (diameter) and 16 m

50 m (between cage centres)

Zero cages in groups 2 and 3 (set either Nx
or Ny to 0 for both groups)

Table 5. Cage layout information required for the Cage Layout sheet — Cage Layout C

Input data variable

Value

Current meter RCM position

Cage group 1 position (Centre of S cage)
Cage group 1

Cage orientation (from S cage)

Change symmetry

Shape

Cage size-Diameter and Depth

Group spacing (x and y)
Other groups

5 cages (Nx) by 2 cages (Ny)

060 degrees

Change symmetry on 2, so that cage 1
position entered above is the S cage and the
second line of cages is to the NW

Circular

32 m (diameter) and 16 m

50 m (between cage centres)

Zero cages in groups 2 and 3 (set either Nx
or Ny to 0 for both groups)




Exercise 2 — Finalising data input and iteration to a consent biomass

Objectives

1.

To enter the remaining data input required for the particle tracking model and
familiarisation and checking of default settings

2. To iterate to a consent biomass value

The following data input are examined in this exercise:

Hydrographic data - current speed and direction data in a pre-defined format
Farm biomass/feed input data/stocking density/cage volume adjustment/biomass
to feed input factor (SFR) — these data are used to determine cage numbers in the
simulation and associated feed input

Information in the Site defaults dialog — waste particle settling velocities and
properties, EQS Benthic parameters

Various switch boxes used during run time

This exercise also familiarises the user with the LOG file.

1.

Click on Model Parameters to view the page. A previous presentation described
the format for current speed and direction data. Copy the current meter data files
(Eck-NS-s.dat, Eck-NS-m.dat, Eck-NS-b.dat) to the appropriate directory. In the
Current files panel if the boxes next to surface, middle and bottom are blank,
files can be loaded into AUTODEPOMOD by clicking on the blank boxes.

So the model iterates to a solution which is independent of where the
hydrographic data record commences in the spring-neap cycle, the radio button
Tidal: Neap-Spring should be selected and the check box Automatically Redo
using Spring-Neap also checked.

In the BENTHIC parameters panel, check the Feed input — constant radio
group button is selected. As the model is being run for peak biomass, a constant
feed input is used in the simulation. Other options (not used in this method) allow
a feed input to be set up as a time series so that feed input can be varied over a
period of time as a farm increases in size.

To check input data on stocking density, cage volume adjustment and SFR, click
on Edit Parameters. By switching Auto-distribute ON, when biomass is
changed between simulations the model calculates the appropriate number of
cages using stocking density and CVA (see section Annex H7.3 for additional
information). Feed input is calculated from the biomass using biomass to feed
input factor (SFR). Although SFR varies with fish weight, an averaged value is
used here. Check input data are correct using the information in Table 6 (white
boxes can be edited by the user, yellow boxes cannot).



The model automatically calculates the biomass and associated feed input for the maximum
number of cages defined at the grid generation stage.

Check the maximum biomass calculation for your scenario using the formula in Annex H eq.
3 p. 88.

Q. What is the feed input in terms of kg cage™ d'?

A.

5. Click on the Cages page tab. As Auto-distribute is switched ON, the biomass is
distributed evenly between cages according to stocking density and is calculated
automatically by the model. For this regulatory method, the user does not need to
modify this page. Click OK when finished.

Notes

6. View default data for the site by clicking on SITE Defaults. Users need to
familiarise themselves with all the data in these pages and check the settings are
correct, using Table 6 if necessary.

7. On the Programs page, the default locations of the DEPOMOD executable files
are specified. This is the background model to the whole AUTODEPOMOD
application and is made up of grid generation, particle tracking and resuspension
model components. In the absence of a CMap application, the location of
Notepad is specified but this does not serve any function.

8. Under the General page, check the number of time steps of current data, the time
step of current data and the trajectory evaluation accuracy are correct. The
trajectory evaluation accuracy is the length of time used for calculation of each
particle trajectory. Check dispersion coefficients are correct.

9. The Benthic page contains some information on refining model runs. To increase
speed of runs, initial model runs are run with 1 particle and then biomass refined
after initial runs with 10 particles. When refining with 10 particles, if a pass is not
achieved, the initial step used in the next test is 100 tonnes.

10. The current data supplied are set up with speed and direction data in columns 5
and 6 and begin with a Neap tide. Check the Tide sequence settings are correct.

11. Check the feed properties are correct. These are used with feed input to calculate
rates of waste feed and faecal discharge.

12. The majority of resuspension model parameters cannot be changed by the user
with the exception of the consolidation time parameter of 4 days. This is the time
the particle is in the benthic fluff layer and available for resuspension. The



13.

14.

15.

16.

Notes

17.

18.

19.

20.

21.

number of loops the model runs for should be set to 2. Neither of these parameters
should be modified by the user.

As the DEPOMOD benthic relationship is validated using total solids (i.e. without
taking into account particle decay), the G-model which is a first-order decay rate
equation is switched OFF. During SLICE modelling runs, the G-model is used to
model decay of the active ingredient.

Check the G-model is switched OFF. Under the Settling Vels. page, both food
and faecal settling velocity data should have normal distributions, rather than
groups. Check the mean and standard deviation for both waste types are set
appropriately.

The EQS Benthic page contains important information on the EQS criteria used
in iteration to a solution. The criteria were varied within reasonable bounds and
tested for numerous sites to determine optimum criteria, as detailed in the
consultation document (see points 13-18 in consultation document). Model runs
are undertaken using different farm biomass until 80 % of the solids remaining in
the grid are enclosed by an ITI contour of 10 + 1% ITI. The boundary of the AZE
is taken as the 30 ITI contour, denoted Sampling ITI. Check setting are
appropriate.

Any changes made to default settings will require justification in the site
methodology submitted with a consent. If any changes are made to the default
data the user is asked if changes are to be saved. Defaults can be restored to
original settings with Restore Defaults, but this is only whilst the dialog has been
open. It does not restore to Global defaults.

Return to the main Model Parameters page where several run time options are
available. Check initial run settings are set to 1 particle and that refining runs are
undertaken at 10 particles (see point 40, consultation document).

Biomass will converge to the nearest solution given by the Convergence value of
5 tonnes.

Use Next Level of accuracy uses the highest level of accuracy available for
calculating particle mass and this is switched ON as default.

As random walk and resuspension are important processes in predicting the fate
of particles, both switch boxes should remain unchecked.

Occasionally, redeposition takes place in areas at some distance from the farm and
these may be real or artefacts of the model caused by the spatially homogenous
hydrodynamic flows in the grid. For example, resuspended particles may intersect
a coastline some distance from a farm and then redeposit in the model grid, but in
reality the current would probably flow around this feature. A blanking file is
used to exclude these outlying areas from AZE calculations in the immediate area
of the farm. If a blanking file has been created, check Use blanking file (also see
Annex H for further information on blanking files).
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Blanking files should be used only where they are strictly necessary. In practice
SEPA has found them to be of use very occasionally. In most circumstances they
have been applied during Calicide assessments. If a blanking file is used then it must
be clearly stated in any modelling report (see Annex H:6.3). In addition model
results, without using the blanking file must be presented.

22. The Test particles and Do scoping runs features are not used in the biomass
consent method.

23. Check the Delete failed runs box. This prevents a build up of large numbers of
unwanted runs. Although the results are saved from each in a log file, the model
results files created for the run are not.

24. The Show log button displays a log file containing important information for each
run. This is an important feature of the AUTODEPOMOD software and users
should have a working knowledge of its contents. On viewing the log file, the user
will see it is currently blank.

25. Click on RUN MODEL.

26. Click OK to accept limit. The model discharges particles according to feed input
and predicts flux at the sea bed as a result of dispersion and resuspension. From
flux, a benthic impact is determined. If this impact is greater than allowable in the
AZE according to EQS criteria, then the site is run with a lower biomass. Once
criteria are met, the model stops and displays the log file.

The log file

27. On completion of the run, the log file shows the feed input and biomass of each
model run. The log file can also be shown at any time by clicking on Show Log.
The important aspects of this log file are:

Pass or Fail - whether the run has passed or failed at the tested biomass
Refinement of runs - once the model run passed, it reiterated at 10 particles and the
refined the run used hydrographic data starting with a Spring tide — the run at 10
particles for a Spring tide is the FINAL SOLUTION

Benthic testing — area occupied by EQS criteria and any other relevant information
Benthic cage group, Flux and trigger — information on equivalent cage group areca
Benthic cage distribution and parameters — number of cages used and relevant
cage parameters (e.g. stocking density)

Sampling area — the area enclosed by the 30 ITI contour (i.e. AZE)

Mass — Mass released and remaining in grid

11



Fill in the following information for Eck log file for the final solution:
Run number and consent biomass -
Benthic testing criteria (% solids and ITI) —

Benthic under cage trigger (mean, maximum flux and equivalent area) —

AZE area and % of solids remaining in grid -

Log file filter function

Right click on the log file and examine the options available under Filter, the next
exercise deals with the mapping module.

By using the filter function to display the relevant information, list the run numbers and
tonnages at which this site failed:
Biomass too high —

Biomass too low -

With reference to the EQS criteria and model predictions of ITI, why does a site fail?

There are also options available under right click to delete failed runs.

Table 6. Input data for the remaining stages of model set up.

Data type Default
Feed properties — wastage (uneaten) 3%
— digestibility 85 %
— water content 9 %
— settling velocity Normal dist.:
p=2383cm s',o=15cms"
Faecal properties — settling velocity Normal dist.:
p=32cm s’ o=1.1cms"
Dispersion coefficients (horizontal and vertical) ky, ky = 0.1 m’ s
k,=0.001 m’s™
Resuspension model parameters Mass Units - g

Particle consolidation time - 4 days
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Farm biomass
Specific Feeding Rate
Stocking density

Cage volume adjustment
Time step of velocity data

Number of time steps

Trajectory evaluation accuracy

EQS test criteria

Mggs - % of footprint particle mass enclosed by
flux (g m? yr') contour

Iggs (ITI threshold) — ITI value at flux contour C
Ieqs(io1) — Pass tolerance for Igqs

Flux trigger
Sampling ITI

Transect ITI sampling values
Flux contour interval for Surfer/Mapping

Convergence value

Loops —2

Calculated by model
0.7 %

17 kg m™

1

60 mins.

15 days of hourly data
1 min

80 %
10 ITI

+ 1% ITI

10 000 g m™ yr™!
30

1,4,20, 30,40
5000

5 tonnes
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Exercise 2A — Running for a single biomass value

Objective

To rerun the model for Eck for a single biomass value

It is occasionally necessary to run the model for a set biomass rather than iterate to a
solution using the EQS criteria. To undertake this, the user needs to enter a feed input to
use in the simulation (the model calculates the appropriate biomass from SFR).
Autodistribute also needs to be switched OFF.

1.

»

Notes

In the AUTODEPOMOD main dialog, click on the Edit Parameters button.
Switch OFF the Auto-distribute biomass function and enter a feed input value
appropriate for a biomass of 400 tonnes. As Auto-distribute is switched off, the
model is now set up to run using the maximum number of cages in the grid.
Therefore, cage numbers are constant.

Return to the main AUTODEPOMOD dialog and Perform Single Run.

In the log file, runs undertaken with Auto-distribute switched OFF are listed as
Manual (feed input weighted to certain cages) or Equal (feed input weighted
equally between cages) under Benthic Cage Distribution Mode and runs with
Auto-distribute switched ON are listed as Auto.

Using the log file, compare this run undertaken with 400 tonnes to a previous run
of similar biomass undertaken with Auto-distribute switched on.
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Exercise 3 — Mapping module

Users should explore using this feature for a run.

From the log file, right click on a run and select Show benthic mapping for run #
Follow the section in Annex H on the mapping module. The objective is to understand

the features of the mapping module and fill out the sheet on Recommendations on
Consenting Biomass.

Notes
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Appendix

Table A. Main input data files (root directory is C:\SEPA Consent\DATA)

File Directory Name

Bathymetry ..Sitename\DEPOMOD\gridgen\ Sitename.csv
Land boundary ..Sitename\DEPOMOD\gridgen\ Sitename.bln
Site INI file ..Sitename\DEPOMOD\gridgen\ Sitename.ini

containing grid
origin

Site summary ..Sitename\ FF-in-Sitename xls
information
Spreadsheet ..Sitename\ Sitename-
toolpack FFMTv3.0.xls
Site default settings | ..Sitename\ SEPA-Sitename.ini
Global default C:\SEPA Consent\ SEPA.ini
settings
Hydrographic data
Surface ..Sitename\DEPOMOD\partrack\current- | Sitename-NS-s.dat
Mid-water data\ Sitename-NS-m.dat
Near-bed Sitename-NS-b.dat
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